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DOON INTERNATIONAl SCHOOL,SRINAGAR 

SUBJECT – Information technology  

Assignment:II 

 Grade:X                               
Chapter:-Word Processing  (intermediate)  

 
➢ The objective of this assignment is to make students get acquainted with 

the factors  that helps in knowing the various new techniques and using 

various other features of word processor. 
 

Microsoft Word 2010 (MS Word 2010) is a word processor, which is used to create and 

edit textual documents. The main element of a document is text therefore, it is essential to 

know how to work  with  in a document. In Microsoft word, we can format the text and 

paragraph that make a document more attractive and professional looking. MS Word  

2010  provides several ways to enhance and control the appearance of the text in a 

document. We can format the text as bold, italic and underline. We can further change the 

font style, font size and font color of the text. We can also make the text more attractive 

by using the styles. 

PARAGRAPH:- A paragraph is a collection of sentences, which is formed from 

words and characters. By default, the paragraph we write in the document does not have 

any formatting. In paragraph format, we can break the lengthy text into multiple 

sentences. 

Line Spacing:- refers to the space between two or more selected lines in a document.  

A document with increased line spacing provides more readability, but consumes more 

space. Alternatively, reduced line spacing saves space in a document, but decreases 

readability of the document. 

Indentation:- Indentation refers to the space between the text and the page 

margins of the paragraph or text. We can indent a single paragraph or multiple 

paragraphs.  Different types of indentations are as follows: 

LEFT : specifies the left indent. 

RIGHT: specifies the right indent. 

FIRST LINE: specifies the first line indent 

HANGING: keeps the text a little inward from the first line. 
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SETTING TABS:- The tab is  used to insert the wide space between the characters and 

words. For single character space we can use the space bar, however for wide space 

(more than one character space), we can use the tab key. 

  Steps To Set The Tabs In A Word Document:-  

1. Click the Paragraph dialog box launcher under the Paragraph group of the Home tabs. 

2. Click the Tabs button in the Paragraph dialog box. 

3. Select the required radio button in the Leader section. 

4. Select the Left radio button under the Alignment section 

5. Type the value in the Tab stop position text box. 

6. Click the Set button to set the tab position. 

7. Click the OK button in the Tabs dialog box. The “L” shaped symbol displays on the 

ruler of the document. This symbol states that the tab stop position has been set. 

8. Click before the paragraph to set the tab. Press the Tab key. 

Now, the paragraph moves to the tab stop position. 

 HEADER: Header is a section at the top of each page between the top margin and the 

first line of the text. Any text or graphic that we insert in a header appears at the top of 

every page in the document. A typical header includes the document’s title and author 

name and dates of creation and modification of a document. We can also insert the 

pictures in the header, which is helpful when we add any logo in the document. We can 

also insert the clip arts and date and time in the header. 

FOOTER: Footer is a section that appears in the bottom of each page. Just like the 

header, we can insert anything in the footer. This information is shown at the bottom of 

every page in the document. A footer usually includes the page number and document 

name. 

STYLES:- Style refers to a set of formatting commands, such as font, font size, bold, 

underline and text color. With the help of styles, we need not to go through different 

command sets and dialogue boxes to get the desired looks of the text. To apply a style, 

we need to just select the appropriate style. In this way styles save a lot of time and effort 

to make the text in a document  more attractive and eye-catching. Though MS Word 2010 

provides several pre-defined styles and style sets, we can also create our own styles. 

*Note:- Prepare a word document on  topic cyber crime and insert a header and footer in 

it. Also apply different styles for important points in it. 

Templates:- Templates offer sets of different predefined visual elements that we can 

later customize according to our requirements. We can create a word document using the 

inbuilt or installed templates and also by using online templates. 
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Steps to create a new document using an online available template: 

• Select the File -> New option. 

• Select the desired template style from the list of templates style under the 

Office.com Templates category, which contains the list of related templates. 

• Select the template that you want to use in the document from the list under the 

Announcement folder. It automatically downloads the lists of available templates. 

• Click the Download button. The process of downloading templates starts. After 

completing the download process, a new document is created by using the 

selected template. 

• Replace the preformatted text with the text as per your requirement and save the 

document. 

 

We can also create our own templates in Ms Word. 

Steps to create own template: 

• Open a document that you save as template. 

• Select the file < Save as option .The save as dialog box appears. 

• Type the name of the word document in the file name combo box. 

• Select the Word  Template option from the save as type drop down list. 

• Click the Save button . 

The document is saved as a template.    

Text Formatting   

 

Text formatting refers to the appearance and arrangement of the text in a document. You 

can apply formatting to a single character, a word, a line, or an entire paragraph. The text 

formatting includes basic formatting operations, such as changing the font and font size 

of the text; making the text bold or italic; applying strikethrough, subscript and 

superscript to the text; changing the color of the text; highlighting the text; and copying 

and clearing formatting. 

 

Subscript And Superscript:- A subscript or superscript is the text that is similar in size 

than the normal text and is placed slightly below or above the line of the regular text. 

Subscripting and superscripting text can be useful for representing the chemical formulas 

or mathematical formulas in our text. In subscript, the selected text or character is placed 

slightly below the line of the regular text. On the other hand, in superscript, the selected 

text or character is placed above the normal text. 

      

      Steps to apply the subscript effect to the text: 

• Select the text on which we want to apply the subscript effect. 

• Click the subscript button under the font group of the Home tab, 

• The subscript effect is applied on the selected text. 
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  We can apply the superscript effect to the text by performing the following steps: 

• Select the text on which we want to apply the superscript effect 

•  Click the superscript button under the font group of the home tab. 

• The subscript effect is applied on the selected text. 

 

Format painter:- 

Format painter button is used to easily and quickly copy the formatting of one text and 

apply it to another text in a document. If we don’t want the same formatting that the 

whole document has, we can clear all the formatting by using clear formatting button. 

 

Perform the given steps to copy the formatting of a text using the Format Painter button. 

•  Select the formatted text in a document. 

•  Click the Format Painter button under the Clipboard group of the Home tab. 

•  Select the text to which you want to apply the copied formatting by using the 

cursor. 

To clear the applied formatting from the text, use the Clear Formatting button under the 

Font group of the Home tab. 

Perform the following steps to clear formatting from the text: 

• Select the text from which you want to clear the formatting. 

•  Click the Clear Formatting button under the Font group of the Home tab. 

• The formatting of the selected text clears. 

 

MS Word provides five types of Case Conversions, which are as follows: 

• Sentence case: In this, the first letter of the sentence is capitalized and rest of the 

sentence appears in lowercase. 

• Lowercase: In this, all the letters appear in small casing. 

• UPPERCASE: In this, all the letters appear in capital casing. 

• Capitalize Every Word: In this, the first letter of each word is capitalized. 

• tOGGLE cASE:  In this, all the letters of each word except the first letter are 

capitalized. 

 

 

Clip Art:- A clip art is a vector-based graphic image in Windows Metafile Format 

(WMF). The main advantage of vector-based images is that they can be resized without 

getting blurred or distorted. The Clip Art feature in MS Word 2010 contains thousands of 

images of different categories such as arts, illustrations, borders, sports, education, 

animals, family and art. 

 

Smart Art:- Smart Art is an improved and enhanced feature included in MS Word 2010. 

It contains more dynamic graphics. Smart Art helps you to create smart business 

diagrams, which not only provide visual enhancement, but also a professional touch to 

the document. Smart Art objects in MS word 2010 are categorized into the following 

categories. 

• All:- Shows smart art graphics of all categories. 
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• Process:-Refers to a type of smart art object that is used to show step based 

information in a document. 

• List:- Refers to a type of smart art object that is used to show non sequential 

information in a document. 

 

• Cycle :- Refers to a type of smart art object that is used to show  a process in 

continuation. 

 

• Hierarchy :- Refers to a type of smart art object that is used to show  structured 

information such as organizational charts and horizontal label hierarchy, in a 

document. 

 

• Relationship:- Refers to a type of smart art object that is used to show two 

interrelated objects in a document. 

 

• Matrix:- Refers to a type of smart art object that is used to show  how various 

parts of one large object fit with each other. 

 

• Pyramid:- Refers to a type of smart art object that is used to show  how various 

parts of a large object fit with each other while showing the largest part either the 

top or the bottom of the pyramid. 

 

• Picture :- Shows a picture to illustrate information. 

 

 

Wrap Text :-Wrap text means adjusting or fitting text into a graphical object. Suppose 

the text that you have typed inside an object does not fit properly into the specified area. 

In this situation, you can use the Wrap Text feature to set the text into the selected object. 

 

Special Characters :-Special characters are those characters that do not represent any 

letter or number. You can find the symbols and special characters by using the Symbol 

button in the Symbols group of the Insert tab. 

  

Inserting Object:-Besides inserting graphical objects, Ms word allows us to insert 

object, Such as Excel spread sheet, Audio and video files, Database files etc. 

Ms Word does these tasks by Linking and Embedding objects 

 

Microsoft Technology namely, object linking and embedding (OLE) gives the facility to 

use the file of one program into another program. 

 

Linking Object:- The information related to a linked object gets automatically updated, 

if the source file is modified. The data relating to the linked object is stored in the source 

file only. The destination file, such as word file keeps only the location of source file and 

it shows delineation of the linked data. The objects should be linked, in case the size of a 

document is a concern. 
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Linking proves beneficial in cases where one wants to add information that needs to be 

maintained independently. If we have some accumulated data that is related to another 

department and when that information needs to be updated regularly, We can link 

objects. 

 

Perform the following steps to link an object in a document: 

• Open a document in which you want to link an object. 

• Select the location where you want to insert the object. 

• Click the down arrow of the Object button in the Text group of the Insert tab. A 

drop-down list appears. 

• Select the Object option from the dropdown list. The Object dialog box appears. 

• Select the Create button from the File tab in the Object dialog box. 

• Click the Browse button. The Browse dialog box appears. 

• Select the file that you want to link in the document. 

• Click the Insert button. The Object dialog box reappears. 

• Select the Link to file check box. 

• Select the Display as icon check box. 

• Click the OK button. 

 

The selected file is linked to the document. 

 

 

Embedding objects:- The information related to the embedding object doesn’t change 

upon any alteration in the source file .Once an object is embedded, it no longer remains a 

part of the source file, but becomes a component of destination file. 

 

  Perform the following steps to embed an object in a document: 

• Open a document in which we want to embed an object 

• Select the location where we wish to embed an object. 

• Click the down arrow of the object button in the text group of the insert tab. A 

drop-down list appears 

•  Select the object option from the drop-down list. The object dialog box appears. 

•  Select the create from File tab in the object dialog box. 

•  Click the browse button. 

•  Select the file that we want to embed in the document. 

•  Click the  insert button, the object dialog box appears. 

•  Click the OK button. 

The selected file will be embedded to the document.  

 

On the basis of understanding of chapter answer the following questions:- 

1.In which case is the text wrapping used in word? 

2.Explain the concept of line spacing. 

3.How to insert symbol and special characters in a document? 

4.How to convert a Ms Word file into PDF ? 

5.How do you magnify your document? 
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Practical work :-  

 

• Create a monthly assignment schedule of different subjects in your curriculum by 

using an online template. Save the Word file with an appropriate name. 

  

• Using internet, search some relevant content on Blogs and Instant  messaging and 

type it down in a word document in different paragraphs .Now insert a header 

containing topic name and date of creation of document. Also insert a footer 

containing your name and page number. 
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DOON INTERNATIONAL SCHOOL,SRINAGAR . 

SUBJECT: ENGLISH 

Assignment:II 

 Grade:X                                             

 The objective of this assignment is to make the students get acquainted with the following 

ideas: 

 Education makes an individual self-sufficient. 

 Modals and their usage. 

 

Poem: A Tiger in the Zoo.(First Flight) 

About the Poet: 

George Leslie Norris was a prize-winning Welsh poet and short story writer. He taught at academic 

institutions in Britain and the United States, including Brigham Young University. Norris is considered one 

of the most important Welsh writers of the post-war period, and his literary publications have won many 

prizes. 

Stanza- wise Summary. 

Stanza I: 

In this stanza, the poet describes the appearance of the tiger in the zoo and its daily movements. He says that 

the tiger moves up and down his cage. The stripes on its body can be distinguished even seen from far as 

they are darker in colour than the rest of its coat. The tiger walks quietly without making a sound because of 

his smooth velvet pads. The tiger is able to walk only few steps because of the length of its cage. It covers 

that distance in a few mere steps only. The tiger is full of anger but it is suppressed because he knows that he 

is helpless here. 

Literary devices: 

Rhyme scheme: abcb is followed (cage-rage) 

Personification: A figure of speech in which an inanimate object or an abstract concept is spoken as though 

it were endowed with life or with human attributes or feeling. In this stanza, the tiger is personified because 

the poet refers him as „he‟. 

Metaphor: A figure of speech in which there is a direct or indirect comparison between two things. In this 

stanza Tiger‟s paws are compared with velvet (pads of velvet). 
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Imagery: It is a figure of speech in which the poet tries to create an image in front of the readers. In this 

stanza the poet tries to create an image of a tiger when he says “He stalks in his vivid stripes / The few steps 

of his cage”. 

Consonance: It is the repetition of a sequence of two or more consonant sounds. In this stanza the „s‟ sound 

in(stalks, his, stripes) are the consonance sounds. 

Assonance: It is the repetition of identical or similar vowels sounds in a sequence. In this stanza the „I‟ 

sound (in his vivid stripes) are the assonance sounds. 

Oxymoron: A figure of speech in which two terms that in ordinary usage are contraries. In this stanza the 

use of adjectives opposite in meaning (quiet rage). 

Stanza II: 

In this stanza, the poet is filled with pity while looking at the imprisoned tiger. The poet imagines an another 

life for the tiger other than the zoo. He says that the poor tiger should have been in his natural habitat that is 

in the wild forest. He says that under normal conditions, this tiger would have been moving in the darkness 

not in the clear daylights. It would have been lying in the shadows of trees or hiding itself behind long grass 

so that its prey is  not be able to detect its movement. In this way, the tiger would have moved near the water 

hole where all the animals of the forest come to drink on sunny afternoons. There, near the water hole, he 

would have been waiting for some fat deer to pass that way. Thus, he would be lying there in expectation of 

a heavy feast. 

Literary devices: 

Rhyme scheme abcb is followed (grass-pass) 

Enjambment: In poetry enjambment means moving over from one line to another without a terminating 

punctuation mark. In this stanza  (Sliding through….deer pass). 

Alliteration: It is the repetition of speech sounds in a sequence of nearby words. In this stanza the use of 

sound „p‟ at the start of two words (plump pass) 

Imagery: It is a figure of speech in which the poet tries to create an image in front of the readers. In this 

stanza the poet has tried to create an image of tiger‟s activities (lurking in shadow). 

Stanza III: 

In this stanza, the poet says that even though he would prefer the tiger to live in the wild, it is not as if it 

would lose all touch with human civilization. He imagines what the tiger will do in case he failed to find any 

prey in his natural habitat. He says that the tiger would be growling at the edge of jungle near some village. 

He would be showing his white fangs and claws while moving here and there with the intention of scaring 

all the inhabitants of that village. He would thus become a cause of terror for the villagers. The poet here 

gives a hint that if we destroy the natural habitat of tigers, they will be forced to turn to our towns and 

villages to find their food. 

Literary devices: 

Rhyme Scheme: abcb is followed (edge, village) 
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Enjambment: In poetry enjambment means moving over from one line to another without a terminating 

punctuation mark. In this stanza (He should be snarling around houses / At the jungle‟s edge,) 

Onomatopoeia: It is the process of creating a word that phonetically imitates, resembles, or suggests the 

sound that it describes. In this stanza (snarling) is the onomatopoeia sound. 

Assonance: It is the repetition of identical or similar vowels sounds in a sequence. In this stanza the use of 

vowel sound „o‟ and „I‟ in (should, around, houses), (Baring, his, white, his) 

Consonance: It is the repetition of a sequence of two or more consonant sounds. In this stanza the use of 

consonant sound „s‟ (his, fangs, his, claws). 

Stanza IV: 

In this stanza, the poet stops imagining the tiger‟s alternate life and returns to its real one. The poet sees the 

tiger caged in a small concrete cell in the zoo like a prisoner in the jail. In spite of all his strength, it now lies 

imprisoned behind the bars. The tiger pays no attention to the visitors who come to see him every day at the 

zoo. Instead of this, the tiger very slowly and silently, moves up and down along the length of the cage 

without any disturbance in the form of human intervention. 

Literary devices 

Rhyme Scheme: abcb is followed (bars-visitors) 

Personification: A figure of speech in which an inanimate object or an abstract concept is spoken as though 

it were endowed with life or with human attributes or feeling. In this stanza, the tiger is personified because 

the poet refers it as „he‟. 

Assonance: It is the repetition of identical or similar vowels sounds in a sequence. In this stanza, the use of 

vowel sound „e‟ (he, locked, concrete, cell). 

Consonance: It is the repetition of a sequence of two or more consonant sounds. In this stanza the use of 

consonant sound „s‟ (his, strength, bars). 

Alliteration: It is the repetition of speech sounds in a sequence of nearby words. In this stanza the use of 

sound „b‟ at the start of two words (behind bars) 

Stanza V: 

In this stanza, the poet describes about the daily routine of the tiger. The tiger does not rest during the day 

because of the visitors. Even at night, it stays awake till the very last voice of the zookeeper can be heard. 

After that too, it does not go to sleep. All night, it remains disturbed due to the noise of the patrolling cars. 

He keeps staring at the brilliant stars with his brilliant eyes. Perhaps he is asking heaven why he has been 

imprisoned there. 

Literary devices: 

Rhyme Scheme: abcb is followed (cars-stars) 

Enjambment: In poetry enjambment means moving over from one line to another without a terminating 

punctuation mark. In this stanza (And stares with his brilliant eyes / At the brilliant stars.) 
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Alliteration: It is the repetition of speech sounds in a sequence of nearby words. In this stanza use of sound 

„h‟ in the starting of two words (he hears) 

Assonance: It is the repetition of identical or similar vowels sounds in a sequence. In this stanza use of „I‟ 

sound (with, his, brilliant) 

Note: ‘Thinking about the poem’ to be done by the students themselves on their classwork notebook. 

     

                                                Poem: How to Tell Wild Animals (First Flight) 

About the Poetess: 

Carolyn Wells is a prolific American writer remembered largely for her popular mysteries, children‟s books, 

and humorous verse. Her famous works are „At the sign of the Sphinx‟ (1896), „The Jingle book‟ ( 1899), 

„The story of Betty‟ (1899). 

Stanza- wise Summary. 
 

Stanza I: 

In this stanza the poetess here cautions the readers against the wild beasts found in the jungle. She says that 

if by chance you happen to go to any forest in the east, you are likely to encounter a huge and terrible animal 

moving forward towards you. You will notice that it is brownish-yellow in colour. And if that beast roars 

loudly at you and you feel that you are going to die due to fear then you will come to know that it is the 

Asian lion. 

Literary Devices: 

Rhyme scheme: ababcc is followed (chance-advance, east-beast, dyin-lion) 

Enjambment: In poetry enjambment means moving over from one line to another without a terminating 

punctuation mark. In this stanza (And if there…..tawny beast) 

Inversion:  It is the change in the format of a sentence. In this stanza (if there should to you advance) 

Assonance: It is the repetition of identical or similar vowels sounds in a sequence. In this stanza the use of 

vowel sound ‟o‟ (you should go, should to you, roars,) 

Allusion: It is an indirect reference to a person, place, thing or idea of historical, cultural, literary or political 

significance. In this stanza the example is (Asian Lion) 

Stanza II: 

In this stanza the poetess says that it is very likely that while roaming in the forest, you are greeted by a wild 

beast. This wild animal is very impressive in size and its majestic body is covered with black stripes on a 

yellow base. The poetess cautions that if the readers notice this beast and that if he eats them, then this 

simple rule will teach them that it is a „Bengal Tiger‟. 

Literary Devices: 

Rhyme scheme: ababcc is followed (round-ground, you-you learn-discern) 
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Alliteration: It is the repetition of speech sounds in a sequence of nearby words. In this stanza the repetition 

of consonant sound „r‟ at start of the two words (roaming round). 

Inversion: It is the change in the format of a sentence. In this stanza (The Bengal Tiger to discern). 

Allusion: It is an indirect reference to a person, place, thing or idea of historical, cultural, literary or political 

significance. In this stanza the example is (Bengal Tiger) 

Assonance: It is the repetition of identical or similar vowels sounds in a sequence. In this stanza the use of 

vowel sound ‟o‟ (or if some time when roaming round) 

Stanza III: 

In this stanza the poetess here helps the readers to identify a Leopard. She says that if you happen to walk in 

the forest, you might encounter a beast with spots on his skin. When this wild beast will jump at you, you 

will understand that it is a Leopard as he will keep jumping on you and will tear you apart. Moreover, it will 

be of no use then to shout or cry with pain because he will continue pouncing on you. So, be careful and 

don‟t allow it to leap on you. 

Literary Devices: 

 Rhyme scheme: ababcc is followed (view- you, peppered- Leopard, pain-again) 

Alliteration: It is the repetition of speech sounds in a sequence of nearby words. In this stanza the repetition 

of consonant sound „h‟ in the beginning of two words (he has) 

Poetic license: A liberty to the poet to change the spellings in order to create rhyme or rhythm in a poem. In 

this stanza the use of „ lept‟ instead of leapt. 

Assonance: It is the repetition of identical or similar vowels sounds in a sequence. In this stanza the use of 

vowel sound „o‟ (strolling-forth-you, whose-spot, do no good to roar) 

Consonance: It is the repetition of a sequence of two or more consonant sounds. In this stanza the use of „l‟ 

sound (he‟ll only lep and lep). 

Stanza IV: 

In this stanza the poetess says that while you are walking in your yard, you may encounter a creature there. 

When this creature hugs you very tightly, then believe that it is a Bear. Bears are thought to be good 

wrestlers and can give a really tight hug. Although a friendly hug is referred to as Bear hug, if a real Bear 

hugs you, then it may not feel friendly at all. The Bear hugs a man to kill him. The poetess further says that 

in case of any doubt you will find that the Bear will embrace you once again till death. 

Literary Devices: 

Rhyme scheme: ababcc is followed (yard-hard, there- bear, guess-caress) 

Enjambment: In poetry enjambment means moving over from one line to another without a terminating 

punctuation mark. In this stanza (if you were walking….creature there) 

Alliteration: It is the repetition of speech sounds in a sequence of nearby words. In this stanza the repetition 

of „w‟ sound (when-walking), „h‟ sound (who- hugs), „b‟ sound (be-bear) 
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Assonance: It is the repetition of identical or similar vowels sounds in a sequence. In this stanza the use of 

vowel „e‟ (meet a creature there) 

Stanza V: 

In this stanza the poetess here says that a novice may be puzzled and confused and thus might not be able to 

distinguish between the different wild animals. Hence, the poetess helps to differentiate the Crocodile from 

the Hyena. She says that a Hyena always laughs as it swallows its victim. A laughing Hyena‟s voice 

resembles human‟s laughing sound. A Crocodile on the other hand, is said to shed tears while eating its 

prey. The poetess, thus, warns the readers to not wait for a Hyena to laugh or for a Crocodile to weep. 

Literary Devices: 

Rhyme: Rhyme scheme ababcc is followed (prey-may, nonplus-thus, smiles-crocodiles) 

Alliteration: It is the repetition of speech sounds in a sequence of nearby words. In this stanza the repetition 

„n‟ (novice-nonplus), use of „th‟ sound (the-thus) 

Enjambment: In poetry enjambment means moving over from one line to another without a terminating 

punctuation mark. In this stanza (though to distinguish….might nonplus, The crocodile…..hyena thus) 

Stanza VI: 

In this stanza the poetess describes a Chameleon in this stanza. She says a Chameleon is a small garden 

lizard. It does not have ears or wings. The poetess, further, says that if you are unable to see a thing on the 

tree, then chances are that a Chameleon is sitting there. A Chameleon is an expert at camouflage. It changes 

colour as per its surroundings and is therefore difficult to see. This capacity of camouflage helps the lizard in 

saving it from hunters. 

Literary Devices: 

 Rhyme scheme: ababcc is followed (small-all, thing-wing, tree-see) 

Alliteration: It is the repetition of speech sounds in a sequence of nearby words. In this stanza the repetition 

of „h‟ sound (he hasn‟t) 

Consonance: It is the repetition of a sequence of two or more consonant sounds. In this stanza the use of „g‟ 

sound (single wing) 

Note: ‘Thinking about the poem’ to be done by the students themselves on their classwork notebook. 

                               

 

   Chapter no. 2: The Thief’s Story. (Footprints without Feet) 

 

About the Author: 
Ruskin Bond is an Indian author of British descent. He lives with his adopted family in Landour, Mussoorie, 

India. The Indian Council for Child Education has recognised his role in the growth of children's literature in 

India. He was awarded the Sahitya Academy Award in 1992 for „Our Trees Still Grow in Dehra‟, his novel 

in English. He was awarded the Padma Shri in 1999 and the Padma Bhushan in 2014. 
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 Plot Summary: 

The story revolves around two main characters, Anil and Hari Singh. Anil is a struggling author and a good 

fellow who takes a teenage boy Hari Singh with him to his home as the teenage boy has no place to go. He 

wants to teach Hari Singh how to read and write. Gradually, Anil develops trust in Hari Singh. On the other 

hand, Hari Singh has been waiting for the right moment to steal some money from Anil. After stealing 

money from Anil, Hari Singh tries to run away. But his inner voice stops him from doing so. He returns to 

Anil because he wants to live a respectful lifet. Anil does not show that he knew about the incident and 

accepts Hari Singh with open arms. Thus, a well intentioned person tries to reform a teenager who had 

diverted from the correct path. 

Question 1: What are Hari Singh’s reactions to the prospect of receiving an education? Do they 

change over time? What makes him return to Anil? 

Answer: In beginning of the story Hari Singh is indifferent towards receiving education, his only goal 

initially is to steal money from Anil. He is not concerned about gaining knowledge. However, eventually 

when Hari Singh chooses to live a respectful and honourable life he realizes the importance of education. 

Thus, his ideas about receiving education changes over time. 

Question 2: Why does not Anil hand the thief over to the police? Do you think most people would have 

done so? In what ways is Anil different from such employers? 

Answer: Anil does not hand over the thief to the police because by doing so he would have pushed Hari 

Singh far away from the right path and that would have lead him towards a life of darkness and ignorance. 

People like Anil are hard to find. Most people would have reacted in predictable ways by thrashing Hari 

Singh and calling police. Anil is different because he wanted  Hari Singh to become literate and lead a 

respectable life in future. 

Note: ‘Talk about it’ to be done by the students themselves on their classwork notebook. 

 

 

   Chapter no.4: From the Diary of Anne Frank.(First Flight) 
About the Author: 

Anne Frank was a German-born Dutch-Jewish diarist. One of the most discussed Jewish victims of the 

Holocaust, she gained fame posthumously with the publication of „The Diary of a Young Girl‟ in which she 

documents her life from 1942 to 1944, during the German occupation of the Netherlands in World War II. It 

is one of the world's best known books and has been the basis for several plays and films. 

Plot Summary of the Chapter: 

This lesson is an excerpt from “Diary of a Young Girl” or “The Diary of Anne Frank”. It is an 

autobiography that was first published in 1947. In this, Anne expresses her thoughts in a diary which was 

gifted to her on her thirteenth birthday. She names the diary “kitty” which she considers as her only true 

friend. She mentions about her childhood, her family and a lot other things that she told no one else. 

In this lesson, Anne Frank is giving an autobiographical account about her life.  Anne talks about being 

lonely and having no one to talk to despite being surrounded by family and around 30 people whom she 

called her “friends”. Thus, she takes the decision of writing her feelings in a diary. It is unusual for her to 
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write in a diary but she is really in need of a true friend. Thus, she decides to name her diary “kitty” and 

unlike other people, she is not going to mention just facts in it. She starts with writing her background, to 

make it easier to understand for anyone who reads it later. She describes her family and early childhood 

when they all migrated, her early schooling. After giving a brief account of her background, she comes to 

the present day where she tells us about the result day. Everyone in the class is nervous about their result and 

boys are even making bets. Anne was quite sure about herself and her friends. She had a good equation with 

all the teachers except her maths‟ professor, who was constantly annoyed at her for her talking habits. Thus, 

he started giving her punishments in the form of essays on weird topics such as “Chatterbox” to which she 

replied with full wit. She used to write essays that were funny and explained that this was a trait that she 

inherited from her mother and not much could be done about it. His teacher kept on giving her essays until 

she wrote a satire.  After that third and last assignment, Mr Keesing never pointed her out for talking. 

Oral Comprehension Check:  

Q1. What makes writing in a diary a strange experience for Anne Frank? 

A. It was the first time Anne was writing in a diary. She felt that later no one would be interested in reading 

about the thoughts of a young girl. Both these facts made it a strange experience for her. 

Q2. Why does Anne want to keep a diary? 

A. Anne wanted to keep a diary and write in it because she had a lot of things going in her mind. She had no 

friend with whom she could talk about such personal stuff and she even felt lonely at times. Thus, she 

decided to maintain a diary. 

Q3. Why did Anne think she could confide more in her diary than in people? 

A. According to Anne Frank, “paper has more patience than people”. She chose to confide more in her diary 

because she felt there was no friend who could listen to her with enough patience. 

Q4. Why does Anne provide a brief sketch of her life? 

A. Anne feels it would be weird to just simply jot down facts without giving her background. In case 

someone might read it in future, he/she won‟t be able to understand vaguely stated facts. Thus, she decided 

to provide a brief sketch of her life. 

Q5. What tells you that Anne loved her grandmother? 

A. The fact that Anne spent some part of her childhood with her grandmother is self-sufficient to imply 

connection between the two. Also, she explicitly mentioned in her diary that she misses her grandmother, so 

this shows that Anne loved her grandmother. 

Q6. Why was Mr Keesing annoyed with Anne? What did he ask her to do? 

A. Mr Keesing, Anne‟s maths professor was annoyed with her because she would not stop talking during his 

lectures as a result of which, he gave her assignments as punishments. 

Q7. How did Anne justify her being a chatterbox in her essay? 

A. Anne explained that she got this habit of speaking too much from her mother, mentioning that it was 

inherited. 
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Q8. What made Mr Keesing allow Anne to talk in class? 

A. On being given the third assignment as punishment, Anne wrote a satirical piece which was quite 

promising. Thus, finally, the professor allowed her to talk. 

Note: ‘Thinking about the text’ to be done by the students themselves on their classwork notebook. 

  

                                                  GRAMMAR: 

 
Modals: 
In English grammar, a modal is a verb that combines with another verb to indicate mood or tense. A modal, 

also known as modal verb or modal auxiliary, expresses necessity, uncertainty, possibility, or permission. 

 

The modals which are used in English are listed in the following table. Based on their varied meanings, a 

speaker/writer can decide which modal should be used to express which meaning. Some modals carry 

overlapping meanings but still each one at least carries a definitive feature that distinguishes it from others. 

 

            Modal Verbs             Meaning Expressed                 Example 

Can  Ability 

 Permission 

 Possibility 

 I can write English. 

 Can I drop you 

somewhere? 

 Obesity can lead to 

diabetes. 

Could (past form of Can)  Ability in the past 

 Request 

 Possibility 

 As a kid, I could run 

fast. 

 Could you bring me 

some water? 

 Their protest could lead 

to trouble. 

Will  Future actions 

 Determined, certain actions 

 Issue invitation 

 I will meet him 

tomorrow. 

 She will surely punish 

me. 

 Will you accompany 

me to the party? 

Would (past form of Will)  Past habits 

 Request 

 Present hypothetical 

situation 

 When I was a child, I 

would spend hours in 

the park. 

 Would you bring me a 

gift? 

 If I were married, I 

would be happier. 

May  Possibility 

 Show purpose 

 Permission 

 Request 

 It may rain tomorrow. 

 She has worked hard 

for the project so that 

she may win the 

competition. 

 May I leave the room? 

 May I borrow your 
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pen? 

Might (past form of May)  Polite Permission 

 Express intuition 

 Lesser possibility 

 Might I give you a 

suggestion? 

 I feel she might take a 

class today as well. 

 Like the previous year, 

you never know she 

might take a long 

holiday this year too. 

Shall  Future action 

 Suggestion, advice 

 I shall take a class 

tomorrow. 

 Shall I bring you some 

books? 

Should (past form of Shall)  Advice 

 Express instructions 

 Express opinion 

 You should practice 

enough questions. 

 You should behave 

properly in front of the 

guests. 

 He should be 

concerned about his 

future. 

Must  Show necessity 

 Express sense of duty 

 Show obligation 

 I must see him. 

 You must ensure 

savings for the family. 

 Children must obey 

their parents. 

Ought To 

                                       

 Obligation 

 Sense of duty 

 Express desirability 

 

 They ought to tell the 

truth. 

 I ought to protect my 

family the best possible 

way. 

 She ought to meet him 

before he leaves. 

 

 

Exercise: 

Fill in the blanks with the most appropriate modals. 

1. _________ (Will, Would, Shall) I carry the luggage for you? 

2. You __________ (should not, would not, ought not to) leave sharp objects lying on the floor when 

kids are around. 

3. He _________ (dare, may, would) not see me if he wants to be spared of my anger. 

4. My nephew __________ (may, could, would) read alphabets when he was just 6 months old. 

5. If you ____________ (should, would, might) see him, tell him to meet me in my office. 

NOTE: All the questions and answers to be done on the classwork notebook. 
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        DOON INTERNATIONAL SCHOOL, SRINAGAR 
SUBJECT: S.ST 

Assignment: II 

Grade: X 

Chapter: Resources: Concept, classification & development. 

      Instructions: 

 The objective of this assignment is to make the students acquainted with; 

1: Changing concept & definition of natural resources. 

2: Classification of resources. 

3: Resource planning. 

4: Environmental degradation & Depletion of natural resources. 

5: Management & Conservation of resources. 

Following are some of the methods which help in management & conserving the Resources: 

1: Principle of Sustainable Yield: Locally available renewable resources should be used where possible, and 

renewable resources should not be used faster than their replacement by natural processes. 

2: Principle of Energy Efficiency: High quality energy should not be used to do something that can be done 

with lower quality energy, for e.g., We don’t need to use a chain saw to cut butter. 

3: Principle of Pollution prevention & Waste reduction:  These are the best & cheapest ways to sustain the 

earth. The best way to control pollution & waste is to produced minimum possible waste.  

4: Principle of three “R” s of earth care: Reducing resource consumption & waste production should be top 

priority, followed by reusing items & recycling key Mineral resources. 

5: Principle of Resource conservation: products or wastes that can be recycled or reused should not be 

dispersed, mixed, burned or buried. 

6: Principle of global Commons: We should leave all the global commons like fresh water & fresh air to our 

next generations as good as we have received them from our ancestors if not in a better position. 

We should follow all these principles so that the idea of Sustainable Earth Prevails.  

                                                    Resource 

Everything available in our environment which can be used to satisfy our needs, provided it is technologically 

accessible, economically feasible and culturally acceptable can be termed as ‘Resource’. For example: Water, 

Air, land, Sunlight, Fossil fuels, Wildlife, Fish and minerals are the resources that are useful to mankind. 
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                                                    Resource Planning & its Various stages 

Resource planning is the judicious use of resources. Resource planning becomes more important in a country 

like India, where resources are not distributed properly. For example; many states are rich in mineral and 

deficient in other resources, such as Jharkhand is rich in minerals, but there is problem of drinking water and 

other facilities, Arunachal Pradesh has plenty of water but lack of other development because of lack of 

resources. Resource planning is the judicious use of resources. Resourse planning becomes all the more 

important in a country like India, where resources are not evenly distributed all over the nation. 

For example, a state like Jharkhand is rich in minerals but has acute problem of fresh drinking water. Arunachal 

Pradesh on the other hand, has plenty of fresh water but lacks in other resources. The alluvial plains of North 

India are mostly devoid of mineral resources. Again, sedimentary rocks in Gujarat and Assam have huge 

petroleum deposits. 

This uneven distribution of resources( under varied geographical conditions) needs to  be administratively 

monitored, controlled and properly planned for judicious use while framed under infrastructural improvement 

and developmental plans. 

This will also disallow and hinder all types of discriminations and pave ways and means for purposeful 

distribution of natural resources based on scientific requirement and on restoration of demand based on 

principles of equity and actual need. 

Hence, resource planning in India( generally) as a procedure of proper utilization of resources is  carried out in 

three phases:  

A) Preparation of Inventory of Resources:  

1)It includes surveying, mapping and measurement of worth & properties of resources. 

2) This inventory is prepared for all the resources available across all the regions of the country. 

B) Evaluation in terms of availability for development: 

1) It examins resources from the point of view of technology, economy and need. 

2) Thus, it evolves well planned structure endowed with right technology, skills and industrial set-up by proper 

planning of judicious use of resources. 

C) Planning for Use and Exploitation of resources: 

1) It emphasises on use, reuse & on mesures of re-cycling of resources. 

2) Thus from time to time resource drvelopment plans and national developmental plans are scrutinized, 

matched & reviewed for the above purpose. 
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     Environmental degradation and depletion of natural resources. 

Environmental Degredation is the phenomenon in which deterioration of environment occurs through 

depletion of resources such as air, water and soil. This has today become one of the major threats as homo 

sapiens have only on Earth to live, sustain and survive. The result of extreme exploitation of the available 

resources (that include water, air, flora, fauna and soil etc,) not only has put human life in jeopardy but also all 

other living species on earth. In reality, when the natural environment is compromised it  reduces the biological 

diversity and weakens the general health of the environment. United Nation has enlisted environmental 

degredation as one of the ten threats for survival of human life on earth. 

The process of degredation can be entirely natural in origin or it can be caused by excessive mortal activities. In 

both ways the deteriorating effect has all possibilities of acceleration. The life on the planet is interwoven to a 

great extent that, decrease in a particular attribute triggers a domino effect in all other attributes. And, finally, 

if the environment is irreparably compromised , it would lead to destruction of ecosystem, habitat destruction, 

steady extinction of wild life and trigger unprecedented pollution, thus, influencing water usage, fossil fuel 

consumption and obviously would have adverse effect on the growth of plants and on all kinds of organic lives 

in the natural sorrounding; hence, if this is allowed to continue,  it could inevitably signal the end of human 

existence on earth. 

DEPLETION OF NATURAL RESOURCES 

This occures when the renewable and non-renewable resources become scarce, these are consumed faster 

than these can be recovered. Moreover, natural resources would take millions of years to recover! It is globally 

ascertained that  environmental degredation is fueled by rising population growth and increasing global 

consumption. Further, it has been observed that some of the resources that are consumed at a faster rate are 

also never getting replenished! Resources beyond their rate of replacement is considered to be 'resource 

depletion'. As matter of fact, all natural resources are depletable that they are capable of being destroyed 

unless care is exercised to maintain them.  

When the expression ' natural resource depletion' is applied it generally refers to water usage, farming, fossil 

fuel, consumption, fishing and mining. 

IMPORTANCE OF NATURAL RESOURCES and THE NEED TO CONSERVE THEM 

1) Nature helps to maintain balance and satisfy the needs to the fullest. 

2) Resources are known as capital converted to commodity inputs to infrastructural capital process. 

3) Natural resources are available in fixed quantity and these are non-renewable. 

4) Resources are important for development of the country. 

5) Natural resources are getting scarce with increasing population. 
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6) The role of natural resources on earth is imperative indeed. For example, coal, oil, soil, water, land, minerals, 

forests, timber and the air we breathe are all  indedpensible for us and for all living species to survive.  

7) Natural resources play a vital role in the economic and infrastructural development of the country. It is 

essential to conserve them.  

Resources are vital for human beings. But indiscriminate use of resources is creating many problems. For 

examples: 

1) Accumulation of resources in only few hands leaves others unsatisfied. 

2) Indiscriminate use of resources is creating many problems around the world such as Global warming, 

Ecological imbalance,  Disturbance in Ozone layer etc. 

3) Thus, equal distribution of resources becomes necessary for sustainable development. 

                                Management and Conservation 

Over use of resources creates many socio-economic problems. Many leaders and thinkers have been 

advocating for the judicious use and conservation of resources. Gandhiji told, “there is enough for every body’s 

need and not for anybody’s greed”. He thought that the exploitative nature of modern technology is the root 

cause for depletion at global level. He believed in the production by masses and not in the mass production. 

Thus, conservation of resources at various levels becomes most important. Resources can be conserved only 

with their judicious use. 

                                  Resource development 

The upgradation or development of resource before they could be properly utilized is called Resource 

development. Example land has to be cleared from unwanted bushes etc. and ploughed before crops could be 

grown in it. Again channels have to be constructed for carrying water to fields. Resource development helps in 

proper utilization of resources.  Resource development is thus systematic utilization of resources. It is not only 

exploitation but also preservation and reuse of resources. 

                                                            Classification of Resources 

 On the basis of origin: 

1: Biotic Resources. 

2: Abiotic Resources. 

 On the basis of exhaustibility: 

1: Renewable Resources. 

2: Non-Renewable Resources. 
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 On the basis of Ownership: 

1: Individual Resources. 

2: Community owned Resources. 

3: International Resources. 

 On the basis of status of the development: 

1: Potential Resources. 

2: Developed Resources. 

3: Stock. 

4: Reserves. 

                            Differences between Biotic and Abiotic Resources 

                BIOTIC RESOURCE                                                                        ABIOTIC RESOURCES 

1: Biotic resources have or had living characteristics.          1: Abiotic resources are composed of non-living 

2: These are normally obtained from the Biosphere.               things. 

3: Examples: Humans, flora, fauna, fisheries and                  2: These are obtained from the lithosphere. 

    Life stock.                                                                                  3: Water, wind, solar energy, rocks, metals, minerals 

                                                                                                                  Etc.               

 

Write down the answers of the questions on your notebook: 

Q1: Justify resources on the basis of origin. 

Q2: Distinguish between Biotic and Abiotic Resources. 

Q3: Discuss resource planning. 

Q4: What is the principle sustainable yield? 

Q5: Write a short note on resource development. 

Q6: Describe resource conservation and resource development. 
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DOON INTERNATIONAL SCHOOL,SRINAGAR 
SUBJECT: PHYSICS 

Assignment:II 

Grade:X 

Topic : Reflection of light 

 

 
➢ The objective of this assignment is to make the students acquainted with; 

• The basic relations and their importance. 

• To understand the image formation by the spherical mirrors. 

• Usage of spherical mirrors in daily life. 

• Determination of nature of mirror, whether it is concave or convex. 

 

 

Relation between f and R. 

For a spherical mirror of small aperture, the focal length of the mirror is equal to half the 

radius of curvature of the mirror. i.e. f = R/2. We will prove it for the concave mirror but it 

equally applicable for convex mirror as well. 

Now consider the concave with pole ‘p’ center of curvature ‘C’ and principal focus ‘F’. 

Suppose a ray of light parallel to principal axis strikes the mirror at point ‘B’, after reflection 

it passes through ‘F’. The line CB is the radius of curvature of the mirror and hence is 

perpendicular to the mirror at point B. 
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Therefore  ∟ABC =I angle of incidence 

And   ∟CBR = r angle of reflection 

Now  ∟ABC = ∟BCF alternate interior angles 

Since   I = r  ∟BCF = ∟FBC 

Therefore, triangle CBF is an isosceles so that: 

  CF = FB 

Since the aperture of the mirror is small, point B is close to point P and hence FB = PF 

Therefore CF = PF 

This means that F is the midpoint of CP. 

 

Sign conventions for spherical mirrors. 

In the ray diagrams of concave as well as convex mirror, we use new Cartesian sign 

conventions for measuring various distances. According to the New Cartesian sign 

conventions. 
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1. The principal axis of the mirror is taken along x-axis of the rectangular coordinate 

system, and pole P of the mirror is taken as the origin. 

2. The object is taken on the left side of the mirror, i.e. light is incident on the mirror 

from the left hand side. 

3. Distances measured in the direction of incident ray of light is taken as positive. 

4. Distances measured in the direction opposite to the direction of incident ray of light 

is taken as negative. 

5. The distances measured upwards are taken as positive. 

6. The distances measured downwards are taken as negative. 

 

Important ray paths 

1. The ray parallel to principal axis will pass through focus after reflection from concave 

mirror. 

2. The ray passing through focus becomes parallel after reflection from the concave 

mirror. 

3. The ray passing through center of curvature retraces its path after reflection from the 

concave mirror. 

4. The ray of light parallel to principal axis seems to come from focus after reflection 

from convex mirror. 

5. The ray of light seems to go towards the center of curvature retraces its path after 

reflection from convex mirror. 

 

Image formation by concave mirror. 

The type of image formed by concave mirror depends primarily on the position of the object 

in front of the mirror. We shall draw the course of rays in the image formation by a concave 

mirror, when an object is moved closer to the mirror, starting from infinity. There are six 

places where we can place an object in front of concave mirror, hence six cases will arise. 

The ray diagrams and the characteristics of the image formed are shown below. 
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Image formed by the convex mirror. 

In convex mirror, no matter where the object is placed in front of convex mirror, the image 

formed is always virtual and erect and lies behind the mirror. The image is always smaller 

than the size of the object. 
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Mirror Formula. 

Mirror Formula is a relation between object distance (u), image distance (v) and focal length 

(f) of a spherical mirror. It can be written as: 

 

  
1

𝑢
+

1

𝑣
=

1

𝑓
   

Or   
1

𝑢
+

1

𝑣
=

2

𝑅
   

 

Linear magnification. 

The linear magnification of a spherical mirror is the ratio of height of the image (h2) formed 

to the height of the object (h1). i.e.  

   𝒍𝒊𝒏𝒆𝒂𝒓 𝒎𝒂𝒈𝒏𝒊𝒇𝒊𝒄𝒂𝒕𝒊𝒐𝒏, 𝒎 =
𝒉𝒆𝒊𝒈𝒉𝒕 𝒐𝒇 𝒊𝒎𝒂𝒈𝒆

𝒉𝒆𝒊𝒈𝒉𝒕 𝒐𝒇 𝒐𝒃𝒋𝒆𝒄𝒕
= 𝒉𝟐/𝒉𝟏 

 

 

The linear magnification is a number that simply tells how much taller the image is than the 

object. For example, if m = 1, it means the image and the object are of the same height. 

From the derivation of mirror formula 

   h2/h1 = v/u  or  m = -v/u 

The arbitrary minus sign given to linear magnification has nothing to do with the relative 

sizes of the object and the image but we can use it tell whether image is erect or inverted 

w.r.t. object. 

i. When the image formed by a spherical mirror is real, it is also inverted and is on 

the same side of the mirror as the object. Since both v and u are negative, the 

ratio m = -v/u is negative. 

ii. When the image formed by a spherical mirror is virtual, it is also erect and formed 

behind the mirror. In this case, u is negative and v is positive so that the ratio m = 

-v/u is positive. 
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The above discussion can be summarized as under: 

If the magnification m is positive, the image is virtual and erect w.r.t the object; if m is 

negative, the image is real ad inverted w.r.t the object.  

 

Spherical Aberration: 

This is the defect of spherical mirrors. Consider parallel rays falling on a concave mirror as 

shown in figure below. The laws of reflection holds for each of these rays at the point each 

strikes the mirror. As you can see, they are not brought to single point. This defect of 

spherical mirrors is called spherical aberration. A parabolic reflector, on the other hand will 

reflect the parallel rays to a perfect focus. However, because parabolic shapes are much 

difficult to make and thus, much more expensive, spherical mirrors are used for most 

purposes. 

 

 

 

 

 

 

                      Parabolic mirror                                  Concave mirror       
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Uses of spherical mirrors 

Following are the uses of spherical mirrors. 

1. A concave mirror is used as a reflector in torches, head lights of old vehicles. 

2. A concave mirror is used as a doctors head mirror to focus light on the body parts like 

eyes, ears, nose, throat. 

3. A concave mirror is also used as a shaving mirror or makeup mirror as it produces a 

magnified image due to which each part of face is treated well. 

4. Large concave mirrors are also used in reflecting type telescope. 

5. A convex mirror is used as a reflector in street lamps. As a result light from the lamp 

diverges over a large area. 

6. A convex mirror is used by driver’s rear view mirror. These mirrors are fitted on the 

sides of the vehicle enabling the driver to see traffic behind for safe driving. This is 

because: 

A convex mirror produces an erect image of the object. 

size of image formed by a convex mirror is much smaller than the object. 

Convex mirror has large field view and hence enable a driver to see much traffic 

behind him.  

7. Convex mirror is used at blind curves to see the traffic which is not visible to other 

person. 
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Assignment questions to be done on fair note book. 

1. A converging mirror forms a real image of height 4cm, of an object of height 1cm 

placed 20cm away from the mirror. Calculate the image distance. What is the focal 

length of the mirror? 

2. An object 4cm in size placed at a distance of 25cm from a concave mirror of focal 

length 15 cm. Find the position, nature and height of the image. 

3. An erect image 3 times the size of the object is obtained with a concave mirror of 

radius of curvature 36cm. What is the position of the object. 

4. When a mirror is rotated through an angle ϴ. Find the angle by which reflected ray 

turned after reflection from plane mirror. 

5. A man is using concave mirror for shaving. If his face is 20cm from a mirror having 

magnification 2, what will be the radius of curvature of the mirror?  
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               DOON INTERNATIONAL SCHOOL, SRINAGAR 

                   SUBJECT:BIOLOGY 

                  Assignment:II   

                   Grade: X 

                 

       CHAPTER: HEREDITY AND EVOLUTION 
___________________________________________________________________   

Instructions- 

• The objective of this assignment is to make students acquainted with the process of  

evolution, its theories, origin of life on earth and various evidences in support of 

organic evolution. 

                                               

                                           TOPIC: EVOLUTION  

The term evolution was coined by Herbert Spencer. It has come from a latin word evolvere 

which means to unfold or unroll.  

 

Evolution may be defined as a naturally occurring slow, continuous and irreversible 

process of change. The changes are due to variations and variations are because of; 

• Error in DNA coping during replication(doubling of DNA before cell division) 

• Crossing over during gametogenesis(gamete formation in sexual reproduction ) 

 

An example to understand how variations affect evolution: 

Let us consider a group of red coloured beetles living in green bushes. They reproduce 

sexually and therefore produce inheritable variations. The beetles are preyed upon by crows. 

The population can meet the following fates:  

• Situation I  

A colour variation occurs in the beetle population during sexual reproduction which results in 

the formation of few green beetles instead of red. The green beetles will pass its colour to its 

progeny. The green beetles can easily mask themselves in the green bushes. Thus, the crow 

cannot see green coloured beetles and cannot eat them. On the other hand red beetles are 

continuously eaten by crow as they are easily visible on green leaves. As a result, there is a 

drastic reduction of red beetles and increased number of green beetles in the population. 

Conclusion: the colour variation was naturally selected and was exerted by crows. It is also 

known as directional evolution. 

 

• Situation II 

Here, again a colour variation occurs which results in the formation of blue beetles. The blue 

beetles will pass its colour to its progeny. The crows can see both blue and red beetles and 

randomly eat them. Initially the number of red beetles are more than blue beetles. However, 

an elephant steps on beetle population. This kills most of the beetles. But by chance the few 

beetles that have survived are mostly blue. The blue beetles will now slowly increase their 

number. 
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Conclusion: it is simply a matter of accidental survival of beetles of one colour that changed 

the common characteristics of the resultant population. This random change in the gene 

frequency occurring by chance in small population irrespective of its being beneficial or 

harmful is called genetic drift.  

 

• Situation III 

Here, the bushes suffer from a plant diseases and the food material for beetles is reduced. The 

average size and weight of beetles decreases due to lack of food. However no genetic change 

occurs despite scarcity of food. After sometime, when bushes once again become healthy the 

average size and weight of beetles once again increases. 

Conclusion: the variation in the beetle population was caused due to some environmental 

factors and there was no genetic change in the beetle population. 

 

 

 

• Acquired and inherited traits 

                     Acquired trait                  Inherited trait 

The traits (variations) which an individual 

develops in its lifetime due to 

environmental factors, use and disuse of 

organs and conscious efforts. 

The traits or characteristics which are 

passed from parents to their offspring. 

These develop due to mutations and 

reshuffling of genetic materials.  

These are not controlled by genes. And 

disappear with the death of an individual. 

 

These are under the control of genes. And 

reappear in coming generations. 

They are somatic variations. 

 

They are genetic variations. 

The influence is restricted to somatic cells. 

 

The influence is restricted to germ cells. 

Examples: muscular body of a wrestler, 

melodious voice of a singer. 

Examples: fused and free ear lobes, height 

of an individual. 

 

 

 

 

• Theories of evolution 

There are two main theories of evolution, 

i) Theory of Inheritance of Acquired Characters also known as Lamarckism. 

Proposed by French biologist Jean Baptist de Lamarck. According to him evolution is a 

result of inheritance of acquired characters and use and disuse of organs. 

However, this theory was discarded by August Weismann who proposed theory of 

continuity of germplasm. It states that only those characters are passed to next generation 

which occurs in the germ cells(germplasm). 
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ii) Theory of Natural Selection also known as Darwinism. Proposed by Charles 

Robert Darwin. This theory believes in struggle for existence and survival of the 

fittest which results in the formation of new species. 

             

 

                                                                                                                       

• Origin of life on earth  

Life originated on planet earth by coming together of biomolecules. It is also called as theory 

of chemical origin of life or naturalistic theory. The theory was given by A.I.Oparin and 

J.B.S.Haldane.   At the time when earth was formed (4.5 billion years ago) the temperature 

was very(800-900oC) high which eventually started coming down. There was no atmosphere 

and no life. This was the time when the lighter elements in their atomic forms started 

interacting and formed molecules. Such as H (hydrogen), C (carbon), N (nitrogen) and 

O(oxygen) got converted to molecular hydrogen(H2), water vapours(H2O),  

ammonia(NH3),methane(CH4) and carbon dioxide(CO2). It is believed that ammonia and 

water vapour were the first inorganic molecules and methane was first organic compound.  

Heavier elements (iron, nickel, etc) settled into the core of the earth. 

Which theory explains the formation of universe? 

 

The condition on earth was of reducing type as there was no free oxygen available. 

The sources of energy were UV-rays from sun, lightning and volcanic eruption. 

As the temperature was going down, it started raining for hundreds of years. This rain water 

became an ideal medium for the interaction of basic organic and inorganic compounds which 

then formed sugars, amino acids, fatty acids, nucleotides and other biomolecules. These 

monomers polymerised and resulted in the formation of complex organic molecules such as, 

 

Sugars----carbohydrates, amino acids----proteins, fatty acid----lipids and nucleotides----

--DNA and RNA. 

 

These complex organic molecules aggregated and developed a covering membrane around 

them giving rise to first form of life-coacervates.  

                    Coacervates------protocells(eobionts)-------first primitive cell. 

 

Stanley Lloyd Miller and Harold C Urey (1953) experimentally proved this theory. 

 

•   Evolutionary evidences 

Many evidences support the doctrine of organic evolution. These are, 
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i) Morphological and anatomical evidences. 

ii) Vestigial organs. 

iii) Palaeontological evidences(fossils) 

 

• Morphological and anatomical evidences 

                 Homologous organs                     Analogous organs 

These are the organs which are similar in 

structure and origin but different in 

function. 

These organs are similar in function but 

differ in their structure and origin. 

They usually differ in their external 

appearance. 

They generally have similar external 

appearance. 

Homology is based on divergent evolution 

i.e all organisms with homologous organs 

have a common ancestry.   

Analogy is based on convergent evolution 

i.e  similarity in adaptation may result in the 

evolution of dissimilar organs to perform 

the same function. 

Examples: i)   Forelimbs of vertebrates, 

such as man, whale, bird, bat and horse. 

ii)Thorns of Bougainvillea and tendril of 

Cucurbita . 

Examples: i) Wings of insects, birds and 

bats. 

ii)Stings of honeybee and scorpion.  

 

• Vestigial organs: these are reduced and non-functional organs present in some 

organisms. Human body has around 180 vestigial organs e.g, nictitating membrane, 

body hair, external ear muscles, vermiform appendix, wisdom teeth, etc. 

 

•  Palaeontological evidences: it is the study of past life based on fossil records. 

Fossils are the traces, remains and impressions of past organisms. They occur in 

sedimentary rocks, peat, asphalt, lava and snow.                                                  

Missing links are the fossil organisms which show characters of two different groups 

of animals. Example, Archaeopteryx lithographica lived in the Jurassic period. It 

shows characters of reptiles and birds.        

 

                                                                    

How to calculate the age of fossils? 

There are two ways;  

• Relative method-fossils closer to the surface are more recent than the midway fossils 

which are recent than the deeper layers. 

 

• Absolute/radioactive method- fossils or pieces of fossils containing rock are analysed for 

content of uranium and lead, radioactive potassium and argon or contents of radioactive 

carbon(C14).    

 



5 Doon International School, Srinagar 

 

 

 

 

ASSIGNMENT 

1. Bacteria have a simpler body plan in comparison to humans. Does it imply that 

humans are more evolved than bacteria? Explain giving reasons. 

2. While digging a pond in a village some fossils were found. On study, it was found 

that the fossils were more than 10,000 years old. 

i) How is age of fossils calculated? Name the method. 

ii) How are fossils formed? 

3. What is meant by evolution of species? 

4. Describe any two evidences for evolution? 

5. Can the wing of a butterfly and wing of a bat be considered homologous? Why or 

why not?        

Note: Write all the notes and assignment work on your fair notebook. 
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DOON INTERNATIONAL SCHOOL, SRINAGAR 
SUBJECT: MATHEMATICS 

Assignment:II 

Grade:X 

Chapter: Arithmetic Progression 
 

Instructions: 

       The objective of this assignment is to make students acquainted with the following: 

1. Identify if a given sequence of numbers form an arithmetic progression. 
2. Identify the first term and common difference of a given AP. 
3. Find the nth term of an AP. 
4. Derive the formula for the sum of first n terms of an AP. 
5. Find the sum of the first n terms an AP. 

 

 

INTRODUCTION: 

We see lot of pattern in our daily lives.  For example, Rohan’s salary in his first year is 2000 and 

he will be getting increment of 500 every year, so his salary for first, second, third, fourth …. 

Will be of the form 2000,2500,3000,3500 ... So here we see the pattern in Rohan’s salary. The 

difference between two consecutive year salaries is constant. In the similar, world around us 

present us these pattern in many form. In this chapter, we will learn a special type of pattern 

called Arithmetic Progression. 

Arithmetic Progression 

An arithmetic progression is a sequence of numbers such that the difference of any two 

successive members is a constant. 

Let us consider following sequences of numbers 

(1) 1,5,9,13,17…. 

(2) 1,2,3,4,5,... 

(3) 7,7,7,7….. 

All these sets follow certain rules. In first set 5−1 = 9 – 5 = 13−9 = 17−13 = 4 

In second set 2−1 = 3−2 = 4−3 = 1. And so on.Here the difference between any successive 

members is a constant. Such sequences are called Arithmetic Progression. Here the position of 
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the numbers/terms is important, the first term is usually denoted by ‘a’ or a1and second by a2 

and so on. 

Thus In mathematics, an arithmetic progression (AP) or arithmetic sequence is a sequence of 

numbers such that the difference between the consecutive terms is constant. Difference here 

means the second minus the first. For instance, the sequence 5, 7, 9, 11, 13, 15, . . . is an 

arithmetic progression with common difference of 2. If the initial term of an arithmetic 

progression is ‘a’ and the common difference of successive members is d, then the nth term of 

the sequence is given by: 

an = a + (n -1) d 

A finite portion of an arithmetic progression is called a finite arithmetic progression and 

sometimes just called an arithmetic progression. The sum of a finite arithmetic progression is 

called an arithmetic series. 

The behavior of the arithmetic progression depends on the common difference d. If the 

common difference is: 

1. Positive, then the members (terms) will grow towards positive infinity. 

2. Negative, then the members (terms) will grow towards negative infinity. 

 

 

                                                           Question /Answer 

Q. Find the 13th term of the AP : 1, 5, 9, . . . 

Solution: 

Here, a = 1, d = 5−1 = 4 and n=13 

We have an = a+(n−1)d 

So, a13 = 1+ (13−1)×5 = 1+60 = 61 

Therefore, the 13th term of the given AP is 61. 

Q. Which term of the AP : 21, 18, 15, . . . is -81? Also, is any term 0? Give reason for your 

answer. 

Solution:  

Here, a = 21, d = 18−21 = −3. 

Let us suppose an= - 81, then we will find value of n. 

As an = a + (n−1) d 

we have, −81 = 21 + (n−1) (−3) 
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              −81 = 24−3n 

            −105 = −3n 

So,            n = 35 

Therefore, the 35th term of the given AP is -81. 

Next, we want to know if there is any n for which an = 0. If such an n is there, then 

21 + (n−1) (−3) = 0 

i.e., 3(n−1) = 21 

i.e., n = 8 

so, the eighth term is 0. 

Q. Determine the AP whose 3rd term is 5 and the 7th term is 9. 

Solution : 

We have, 

               a3 = a+ (3−1)d = a+2d = 5…. (1) 

and      a7  = a + (7−1)d = a+6d = 9   …. (2) 

Solving the pair of linear equations (1) and (2), we get 

a = 3, d = 1 

Hence, the required AP is 3, 4, 5, 6, 7, . . . 

Q. In which of the following situations, does the list of numbers involved make an arithmetic 

progression, and why? 

(i) The taxi fare after each km when the fare is ₹ 15 for the first km and ₹ 8 for each additional 

km. 

(ii) The cost of digging a well after every metre of digging, when it costs ₹ 150 for the first metre 

and rises by ₹ 50 for each subsequent metre. 

Solution: 

(i) From the given data we see that 

Taxi fare for 1st km = 15 

Taxi fare for first 2 kms = 15 + 8 = 23 

Taxi fare for first 3 kms = 23 + 8 = 31 

Taxi fare for first 4 kms = 31 + 8 = 39 

Clearly 15, 23, 31, 39 … … forms an AP since every term is 8 more than the preceding term. 

i.e., (23 − 15) = (31 − 23) = (39 − 31) = 8 
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(ii) Cost of digging for first metre = ₹ 150 

Cost of digging for 2m metre = 150 + 50 = ₹ 200 

Cost of digging for 3m metre = 200 + 50 = ₹ 250 

Cost of digging for 4m metre = 250 + 50 = ₹ 300 

Clearly, 150, 200, 250, 300 …. forms an AP because every term is 50 more than its preceding 

term. 

Q. Write first four terms of the AP, when the first term 𝑎 and the common difference d are 

given as follows: 

(i) 𝑎 = 10, 𝑑 = 10 

(ii) 𝑎 = −2, 𝑑 = 0 

Solution:  

(i) Given: 𝑎 = 10, 𝑑 = 10 

First term = a1 = 𝑎 = 10 

Second term = 𝑎2 = 𝑎1 + 𝑑 = 10 + 10 = 20 

Third term = a3 = a2+ 𝑑 = 20 + 10 = 30 

Fourth term = 𝑎4 = 𝑎3 + 𝑑 = 30 + 10 = 40 

Hence, the first four terms of this AP are 10, 20, 30, and 40. 

(ii) Given: 𝑎 = −2, 𝑑 = 0 

First term = 𝑎1 = 𝑎 = −2 

Second term = 𝑎2 = 𝑎1 + 𝑑 = −2 + 0 = −2 

Third term = 𝑎3 = 𝑎2 + 𝑑 = −2 + 0 = −2 

Fourth term = 𝑎4 = 𝑎3 + 𝑑 = −2 + 0 = −2 

Hence, the first four terms of this AP will be −2, −2, −2, and −2. 

Q.Choose the correct choice in the following and justify:  

(i) 30th term of the AP: 10, 7, 4, . . . is 
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(A) 97 

(B) 77 

(C) – 77 

(D) – 87 

Solution: 

(i) Given:  

AP: 10, 7, 4 … 

First term, 𝑎 = 10 

Common difference, 𝑑 =a2–𝑎1 = 7 − 10 = −3 

We know that, 𝑎n= 𝑎 + (𝑛 − 1)𝑑 

Substituting 𝑛= 30, 𝑎 = 10 , 𝑑 = −3, we get 

            𝑎30 = 10 + (30 − 1) × (−3) 

⇒        𝑎30 = 10 + (29) × (−3) 

⇒        𝑎30 = 10 − 87 = −77 

Therefore, the correct answer is C.  

Q. Which term of the AP : 3, 8, 13, 18, . . ., is 78?  

Solution:  3, 8, 13, 18, . .. 

For the given AP,  

𝑎 = 3  

𝑑 = 𝑎2 − 𝑎1 = 8 − 3 = 5 

Let 𝑛th term of this AP be 78.  

   𝑎𝑛 = 𝑎+ (𝑛 − 1)𝑑 

Substituting the values,  

                  78 = 3 + (𝑛 − 1)5  
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⇒               75 = (𝑛 − 1)5 

⇒             (𝑛 − 1) = 15 

⇒                      𝑛 = 16 

Therefore, 16th term of the given AP is 78. 

Q. Find the 31st term of an AP whose 11th term is 38 and the 16th term is 73.  

Solution: According to the question, 

 It is given that, 𝑎11 =  38,     𝑎16 = 73  

We know that, 𝑎𝑛 = 𝑎 + (𝑛−1) 𝑑  

Substituting the values, 

             𝑎11=𝑎 + (11−1) 𝑑 

 ⇒        38 = 𝑎 + 10 𝑑         … (1) 

 Similarly, substituting the values, 

             𝑎16 = 𝑎 + (16−1) 𝑑  

⇒          73 = 𝑎 + 15𝑑        … (2)  

On subtracting (1) from (2), we obtain 

         35 = 5𝑑  

⇒       𝑑 = 7  

From equation (1), 

          38 = 𝑎 + 10 × (7) 

 ⇒     38 −70 = 𝑎 

 ⇒      𝑎 = −32  

Therefore, 𝑎31 = 𝑎 + (31−1) 𝑑 = −32 + 30 × (7) = −32+210 = 178 

 Hence, the 31st term in given AP is 178. 
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SUM OF FINITE TERMS OF AN AP 

Carl Fredrick Gauss (1777-1855), one of the greatest mathematicians of all times stunned his 

teacher by adding 1 +2 + 3 +... +99 + 100 within an extremely short interval of time. 

Here is how he did it. 

                              Sum S = 1+2+3 +... +98 +99 + 100 

(In reverse order)S = 100 +99 +98 +... +3 + 2+ 1 

By adding vertically the respective terms in two expressions for S, he realised that adding the 

first and last number, 1 and 100, gives 101 and adding the second and second last number, 2 

and 99, gives 101, as well as 3 + 98 = 101 and so on. Thus he concluded that there are 100 sets 

of 101 in double the sum, 

2S = 100x 101 

i.e., S = 5050 

Using the same strategy as the one used by Gauss, we can find the sum of a finite number of 

terms of an AP. 

In order to find the sum of first n terms of the AP a, a + d, a + 2d, ... 

Let us consider the nth term of this AP = an= a + (n-1) d  

Let the sum up to n terms of the given AP be Sn 

Then, Sn=a + (a + d) + (a + 2d) +. ..+ [a +(n-2)d] + [a + (n- 1)d]     …      (1) 

Writing the above expression in reverse order (same strategy as Gauss) 

S n  = [a + (n -1)d] + [a + (n - 2)d]+ . . . +(a + d) + a      ….  (2) 

Adding (1) and (2) vertically: 

2S n = [2a + (n-1)d] + [2a + (n -1)d] +. . . + [2a + (n-1)d]   ( n times) 

2S n = n [2a + (n-1)d]  

S n = 
𝑛

2
 [2a + (n-1) d] = 

𝑛

2
 ( a + a n) 

If there are only n terms in an AP, then a n = l, the last term 
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Then,   S n =  
𝑛

2
 ( a + l ) 

Note:    a n  = S n  – S n-1 

i.e. The nth term of an AP is the difference of the sum to first n terms and the sum to first (n -1) 

terms of it. 

 

                                                                    Question/ Answer 

Q. How many terms of the AP : 9,17,25,... must be taken to give a sum of 636? 

 Solution: Let n number of terms in the given AP be taken to give a sum of 636. 

It is given that for this AP, 𝑎 =  9,     𝑑 = 𝑎2−𝑎1 = 17 – 9 = 8. 

We know that, 𝑆𝑛 = 
𝑛

2
 [2𝑎 + (𝑛−1) 𝑑] 

 Substituting the values, 636 = 
𝑛

2
 [2×9 +(𝑛−1)8] 

 ⇒                                     636 = 
𝑛

2
 [18 + (𝑛−1)8]  

⇒                                     636 = n [9+4𝑛−4] 

 ⇒                                      636 = 𝑛 (4𝑛+5)  

⇒                      4𝑛2+ 5𝑛 – 636 = 0  

⇒            4𝑛2+53𝑛 − 48𝑛 – 636 = 0    [Factorisation by splitting the middle term]  

⇒      𝑛 (4𝑛 + 53) − 12(4𝑛 + 53) = 0 

⇒     (4𝑛 + 53) (𝑛 − 12) = 0  

Either,  4𝑛 + 53 = 0 or 𝑛 – 12 = 0  

⇒   𝑛 = −53/4 or 𝑛 = 12, 𝑛 cannot be −53/4. As the number of terms can neither be negative nor 

fractional, Hence, 𝑛 = 12 

Thus 12 terms of the given AP must be taken to give a sum of 636. 

Q. The first and the last terms of an AP are 17 and 350 respectively. If the common difference is 

9, how many terms are there and what is their sum? 

Solution: According to the question, it is given that, 𝑎 = 17,   𝑎𝑛 = 𝑙 = 350,  𝑑 = 9 
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 Let the number of terms in the given AP = 𝑛. 

 We know that, 𝑎𝑛 = 𝑙 = 𝑎 + (𝑛−1) 𝑑 

 Substituting the values, 350 = 17 + (𝑛−1) 9 

 ⇒            333 = (𝑛−1) 9  

⇒          (𝑛−1) = 37 

 So, 𝑛 = 38 

 We also know that, 𝑆𝑛 = 𝑛/2 (𝑎 + 𝑙)  

Substituting the values, 

 ⇒       𝑆38 = 38/2 (17 + 350) = 19 (367) = 6973 

 Hence, the given AP contains 38 terms and their sum is 6973. 

Q. Find the sum of first 51 terms of an AP whose second and third terms are 14 and 18 

respectively. 

 Solution: As per the question, for the given AP: 𝑎2 = 14,   𝑎3 = 18,  𝑑 = 𝑎3−𝑎2 = 18 − 14 = 4 

      Since, 𝑎2 = 𝑎 + 𝑑  

⇒       14 = 𝑎 + 4  

⇒       𝑎 = 10. 

 We know that, 

             𝑆𝑛 = 𝑛/2 [2𝑎 + (𝑛−1) 𝑑] 

 ⇒     𝑆 51 = 51/2 [2×10 + (51−1)4] = 51/2 [20 + (50) (4)] = 51(220)/2 = 51(110) = 5610 

 Therefore, the sum of first 51 terms of the given AP is 5610. 

Note: students are directed to solve and write the exercises/assignments of this chapter on fair 

copy. 
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                                                               Assignment  

• In which of the following situations, does the list of numbers involved make an 

arithmetic progression, and why? 

1. The amount of air present in a cylinder when a vacuum pump removes 1/4 of the 

air remaining in the cylinder at a time. 

2.  The amount of money in the account every year, when ₹ 10000 is deposited at 

compound interest at 8 % per annum. 

• Write first four terms of the AP, when the first term 𝑎 and the common difference 𝑑 are 

given as follows: 

1. 𝑎 = 4,   𝑑 = −3           2.    𝑎 = −1,   𝑑 = 1 2              3.     𝑎 = −1.25,   𝑑 = −0.25 

• Find the 31st term of an AP whose 11th term is 38 and the 16th term is 73. 

• An AP consists of 50 terms of which 3rd term is 12 and the last term is 106. Find the 

29th term. 

• The 17th term of an AP exceeds its 10th term by 7. Find the common difference? 

• Which term of the AP: 3,15,27,39,... will be 132 more than its 54th term? 

• Two APs have the same common difference. The difference between their 100th terms 

is 100, what is the difference between their 1000th terms? 

• How many three-digit numbers are divisible by 13? 

• How many multiples of 7 lie between 100 and 200? 

• In an AP:  

(i) Given 𝑎 = 5, 𝑑 = 3, 𝑎𝑛 = 50, find 𝑛 and 𝑆𝑛. 

 (ii) Given 𝑎 = 7, 𝑎13 = 35, find 𝑑 and 𝑆13. 

 (iii) Given 𝑎12=37, 𝑑 = 3, find 𝑎 and 𝑆12.  

• The first term of an AP is 5, the last term is 45 and the sum is 400. Find the number of 

terms and the common difference? 


